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Circuits impresos amb l’Orcad 
 
 
 
 
 
 
 
 
 
 
 
 

1. Introducció 
 
 Dins d’un muntatge electrònic té una importància cabdal les connexions entre els 
elements del muntatge. Per a la construcció física de circuits amb freqüències de 
funcionament fins als Gigaherzos (109 Hz, GHz) fem servir un substrat dielèctric 
anomenat circuit imprès (c.i.). En el circuit imprès posem les pistes de connexió, de 
coure, entre els components del circuit.. Per a fixar els components les línies de 
connexió s’acaben amb uns forats metal·litzats, que és a on soldem els components. 
 Els substrats més emprats per fer circuits impresos i per a ordre creixent de 
freqüència de funcionament del circuits electrònics que porten són: fibra de vidre, 
baquelita, tefló i ceràmics. 
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1.1 Circuit imprès 
 
 Els components (circuits integrats, resistències, condensadors etc.) es connecten 
a les pistes de coure per mitjà de forats fets a la placa dielèctrica o els components es 
solden sobre la superfície de la pista, tècnica SMD (Surface Mount Device) sense tenir 
cap forat. A la propera figura podem veure circuits integrats i components disipatius fets 
amb les dues tècniques 
 

 

 
 
 
 Segons el nombre de capes amb que construïm el circuit imprès podem parlar de 
circuits impresos a: 
 
 
 
  · Una capa 
   Amb els components i pistes amb una única cara 
  · Dues capes 

Amb components i pistes a la cara superior, Top, i amb pistes a la 
cara inferior, Bottom. 

 
  · Multicapa 

Pot tenir més de dues capes, en concret l’Orcad pot arribar a 
dissenyar circuits continguts en dotze capes més la Top, la 
Bottom, Vcc i GND. La cara Top i la Bottom són iguals que pel 
cas de dues capes, mentre que les altres capes que només tenen 
pistes elèctriques es van apilant una al damunt de l’altra , i com a 
element de separació es van posant capes de dielèctric. Aquesta 
opció necessita d’una maquinaria molt cara, per tant quan s’ha de 
fer un circuit imprès amb aquestes característiques  

 
 Per a connectat les pistes de coure dels circuits impresos de més de dues cares es 
fa servir uns forats metal·litzats anomenats via.  
 Atesa a la raó econòmica abans esmentada, els nostres circuits impresos seran a 
una o dues capes i per a fer-ne un haurem d’anar a comprar plaques substrats dilèctrics 
coberts per una capa de coure una cara o dues capes de coure una cada cara. Perquè 
puguem fer les pistes de connexió les diferents capes de coure han de portar una resina 
fotosensible. Aquesta resina varia amb llum ultravioleta.  
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La resina pot ser positiva o negativa. La resina positiva s’elimina al ser atacada 
amb llum ultravioleta. Mentre que la resina negativa n o s’elimina al ser atacada amb 
llum ultravioleta. Nosaltres farem servir resina positiva. 
 
 
 
 
1.2 Tècnica per a fer una placa 
 

1.  Dibuix de l’esquema elèctric. Això ho fem amb el programa Capture de 
l’Orcad 9.2. 

2.  Posada de components a la placa. Amb el Layout Lite de l’Orcad 9.2 
3. Traçat de les pistes. També amb el programa Layout Lite de l’Orcad 9.2 
4. Creació del fotolit. Impresió de les pistes sobre paper vegetal 
5. Insolació de la placa. Com que normalment emprarem plaques 

sensibilitzades positivament al posar el fotolit al damunt de la placa i 
il·luminar-la amb llum ultravioleta s’elimina la resina que ha sigut 
il·luminada per els raigs, és a dir toa la resina que no està protegida per el 
fotolit es desfarà. El temps d’insolació varia de 2 a 5 minuts. 

6. Revelat de la placa. En aquest estadi emprarem un líquid que en el nostre 
cas es menja la resina que ha estat il·luminada. Així hem aconseguit que el 
coure de les pistes està protegit per una capa de resina.  

7. Atac químic. La placa es posa en un bany d’àcid que es menja el coure que 
no està protegit.  

8. Rentat de la placa. Es renta la placa per a treure l’àcid que pugui quedar 
9. Foradat de forats de components i vies. Amb un taladre fem tots els forats 

que la placa necessita per a poder-hi posar els components. 
10. Metal·lització dels forat i soldadura dels components. Abans de soldar els 

components es preparen les illes dels forats i les vies per després soldar-hi 
els components. 
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1.3 Revelat i atac químic 
 
 El primer que farem serà la insolació de la placa de coure, sensibilitzada, per el 
fotolit del circuit imprès. En aquest procés la llum topa amb las zones de la placa de 
coure que no tenen coure, protegint el coure que formarà el circuit imprès. El procés 
triga de l’ordre de 1 minuts i 20 segons-40segons.  
 A l’etapa de revelat emprarem sosa càustica com a revelador amb 
concentracions entre 12 i 25 gr/litre segons sigui el gruix de la capa de resina. Després 
de l’operació de revelat només quedarà la protecció del coure sobre les pistes del circuit 
elèctric. El temps que triga el revelat varia de 10 a 30 segons i acaba quan mirant la 
placa podem veure les pistes i illes de coure. Un cop fet tot això i abans de passar a la 
següent etapa rentarem bé la placa. 

L’atac químic el farem una barreja de : Aigua oxigenada de 110 volums (25%) 
+ Salfumant (25%) + Aigua (50%). Posem la placa a dins de la solució fins que 
l’escuma que es produeix desapareix. 

El temps d’atac es variable i acaba quan podem veure mirant la placa que tot el 
coure no protegit s’ha eliminat, per aquesta barreja d’àcids és d’un 1,5 a 3 minuts. 
 Després de l’atac químic tornem a insolar la placa per a treure la capa que 
protegeix a les pistes i pads fets al circuit imprès. I eliminem la capa fent un segon atac 
químic. Aquesta segona passada es fa per eliminar la capa aïllant que no ens deixaria 
soldar bé els components.  
 Una altre manera de fer l’atac químic és amb una solució de Perclorur fèrric 
que podem trobar en el comerç.  
 
 
 
 

2. Eines CAD per fer circuits impresos 
 
 L’Orcad és un dels entorns CAD emprat més emprats per fer circuits impresos . 
Aquest entorn, bàsicament, consta de dues parts. Una part per proporcionar el circuit 
electrònic què volem posar en e circuit imprès. Una altra part què tenint en compte la 
informació subministrada a la primera part, posa els components i dibuixa les pistes de 
connexió entre els components del circuit. 
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3. 1 Capture 
 
 El programa Orcad Capture serveix per a entrar un esquema elèctric per a poder-
lo simular o fer un circuit imprès. Amb el programa, a més, podem treballar amb fitxers 
vhdl i amb i amb PLD. 
 Al començar creem un fitxer projecte o un fitxer disseny. Al fer això se’ns 
demana si volem: analog, pc board wizard, progammable logic wizard, schematic . 
Nosaltres activen l’opció Pc Board Wizard. 
 

New → Project → Pc Board Wizard 
 
 Al fer un projecte nou creem una carpeta amb una pàgina per a l’esquema. Un 
projecte consta d’un disseny anomenat fitxer.dsn. El disseny té diverses carpetes del 
disseny i una carpeta de cache que té tos els components del disseny. Cada carpeta pot 
tenir un o més esquemes. 
 
 
 
 
3 .2 Barra d’eines 
 
 Per a treballar editant esquemes l’entorn de l’Orcad Capture té una barra d’eines, 
també anomenada Toolbar que està a la part de dalt de la pantalla, amb les opcions: file, 
edit, view, place, macro, accesories, options, windows, help. Un resum d’això surt a la 
part dreta de la pantalla.  
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Cursor 
 
Posar component 
 
Posar cable 
 
Posar nom a un net 
 
Posar un bus 
 
Posar/traure node 
 
Posar un bit d’un bus
 
Posar positiu  
 
Posar massa 
 
 
Posar bloc jeràrquic 
 
Posar un port 
 
Posar un pin 
 
Posar pin fi de pàgina
 
Pin no connectat 
 
Dibuixar línia 
 
Dibuixar polígon 
 
Dibuixar rectangle 
 
Dibuixar el·lipse 
 
Dibuixar arc 
 
Posar text 
 

Tot seguit farem una petit resum de les ordres 
més comuns que hi ha a la figura del costat. 
Posar component. Aquesta icona ens permet 
escollir un component d’una llibreria, per tant 
cal carregar abans la llibreria. Si polsem “ part 
Search” ens busca el component sense necessitat 
de carregar la llibreria. 
Posar un nom a un net. Emprat per a donar 
noms a nets i a busos. 
Posar un bus. Ens permet agrupar cables. Per 
exemple data[0..8] 
Posar un bit d’un bus. Quan creem un bus ens 
permet assignar cada bit al bus 
Posar un bloc de jerarquia. Permet crear blocs 
jeràrquics  
Posar un port. Permet entrades i sortides que 
després són cridades per un bloc jreàrquic. 
Posar pin. Ens permet afegir pins en un bloc 
jeràrquic o en un component. 
Posar pin fi de pàgina “off-page”. Connecta 
entrades/sortides de dues pàgines d’un mateix 
nivell jeràrquic, útil per a esquemes molt 
grossos. 
Eines de dibuix i text. Les ordres que venen tot 
seguit són  per s fer dibuixos i posar text. 
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 La mecànica a seguir per entrar un esquema electrònic és anar afegint 
component a component i connectant los per mitjà de el regle vertical que hi ha a la 
dreta de la pantalla, tot tenint en compte  

 
1 La incorporació dels components és amb Place part1 
2 Per posar positius i masses utilitzem les ordres PWR i GND de la dreta 
3 Fer les pistes amb Trace wire4 Posar capses d’entrada/sortida (headers) per 
   tenir controlats tots els senyals que intervenen en un circuit. 

 
 
 
3. 2. 1 Editar un component 
 
 Els components que anem afegint al circuit tenen unes propietats que pot 
interessar modificar. Per a modificar un component, editar-lo, cliquem dues vegades 
sobre el component i premem el botó dret, sortint el menú d’edició de propietats 
següent. 
 
 

 
 
 
D’aquest a pantalla les propietats més importants són: 
 

1. Filter by. Només deixa veure les propietats que calen al programa que tracte 
les dades generades per l’Orcad. En el nostre cas posarem Orcad Layout, 
perquè les dades generades s’han de tractar amb el programa que fer les 
pistes d’Orcad conegut com a Layout 

2. Reference. Què és el nom que l’Orcad assigna a cada component, cada 
component té una referència diferent. 

3. Pcb footprint. És l’encapsulat físic del component o també és el nom del 
component per a el programa de routing Orcad Layout. És aconsellable quan 
es dibuixa un component amb el capture anar al layout i veure el seu nom 
equivalent, sinó ho demanarà ens ho demanarà el programa de Layout quan 
l’executem.  
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 Sí utilitzem un circuit imprès format amb varies unitats bàsiques (per exemple) 
el 7406) que té sis inversos en un mateix xip. Anem posant els diferents inversors i els 
editem i el component i amen posant les lletres A, B, C i D que li toqui i I el Part 
Reference el mateix per tot l’integrat ( U2C per exemple). 

 Una pantalla molt important i relacionada amb aquesta pel que fa l’alimentació i 
la massa és “Edit Part”. És important perquè si seleccionem un circuit integrat i 
n’editem el part podem variar el nom de l’alimentació i la massa. Això és molt 
important perquè TOTS ELS CIRCUITS HAN DE TENIR EL MATEIX NOM PER A 
L’ALIMENTACIÓ I PER A LA MASSA. Per aquesta raó s’ha de buscar el nom del 
component al programa Layout i posa’l 
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3. 2. 2 Crear un component nou 
 
 Per a fer un dibuix al nostre gust hem de crear una llibreria i a dins d’ella posar 
components. Així per crear un component nou en una llibreria (.olb) fem  
 

File → New Library (New Project per a llibreria nova) 
 

Tot seguit anem a l’arbre File de l’esquerra de la pantalla i ens posem al damunt 
de c:\ … \library1.olb i  li canviem el nom (botó dret) i el guardem amb Save as 
Nom_llibreria.olb. Tornem al botó dret i i cliquem l’opció New Part i anomenem el 
component que farem. 
 A continuació utilitzarem el menú de la dreta per crear el component (els 
símbols amb Place IEE Symbols , les potes d’entrada/sortida amb Place Pin etc.)  
 

L’ordre de Place Pin necessita que li posem el nom de l’entrada/sortida, tipus 
(entrada, sortida, bidireccional, potència etc.). Per a entrar noms que són negats s’ha de 
anar negant cada lletra per separat (R\E\S\E\T\). 
Per afegir un component a una la llibreria ja creada fem 

 
Open → Library →New Part 

 
Després s’ha d’afegir la llibreria i el component amb 
 

Add llibreria 
 
 
 
 

3. 3 Fitxer netlist 
 

Un cop s’ha acabat el dibuix de l’esquema del nostre disseny crearem el fitxer de 
connexions o fitxer netlist, que té la informació dels components i de les connexions 
dels diferents nodes. Això s’aconsegueix anant a Create netlist 

Aquest fitxer és el fitxer d’entrada del programa (Layout) que dibuixa les pistes 
de connexió entre components. Aquest per a el programa Layout té una extensió .mnl i 
no es pot editar. 

Quan generem el fitxer.mnl li hem de dir si al fer les pistes emprarem unitats 
mètriques o en polsades, normalment emprarem polsades. 

Si volem tenir un fitxer editable de les connexions cal anar al driver del tango, 
aleshores el fitxer té una extensió .net. Per fer això hem d’anar a  
 

Tools → Create netlist → Other → Tango.dll 
 
 
 
 

4. Disseny multinivell 
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 A l’emprar carpetes en un sol projecte ens permet crear blocs jeràrquics. La 
finestra del projecte funciona com a un explorador de windows a nivell de: copiar i 
moure's entre carpetes. 
 Per a fer un disseny jeràrquic posem tots els fitxers al mateix nivell. El primer 
què em de fer és crear un projecte, sense cap llibreria 
 

Project  Pc Wizard 
 
 Un cop a dins del disseny i amb la pestanya PCB File i posats a \filtre.dsn, fem 
els dissenys que calguin, botó dret i New schematic. Tants com dibuixos tinguem. Dins 
del nou esquemàtic fem una pàgina nova,  
 

New page → Page 2 
 

Fem el dibuixos més interns. Les entrades i sortides del disseny son per pads, 
fent Place hierarchical port. 

Mirem si l’opció Snap to grid a Grid to display del menú de Preferences està 
activada. 

Passem al dibuix del nivell més alt en el disseny jeràrquic i allà cridem al dibuix 
subordinats anant a Place hierarchical block (menú de la dreta de la pantalla) 
Contestant el diàleg que hi surt. 

 
Reference, Nom del bloc → Pepet, per exemple 
Implementation type → Schematic View (normalment), també pot ser un projecte. 
Implementation name→ Nom de l’esquema que cridem (al dibuix PAGE2) 
Path → No és posa rés si el fitxer cridat està en el disseny, sinó cridem el fitxer.dsn en 
un altre directori 

Anem al dibuix arrel i creem una capsa, amb només arrossegant el ratplí. Això 
es fa una només una vegada per a cada component jeràrquic creat. Tot seguit i si no han 
estat creats creen els pins de la capsa amb Place hierarchical pin . Com a prova de que 
el disseny jeràrquic està ben fet, ens posem a sobre i fem Descend hierachical, i ha de 
sortir l’esquema crida’t 
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5 Orcad layout 
 

El programa Orcad Layout ens permet generar els fotolits per a crear les pistes 
de coure del circuit imprès. L’entrada d’aquest programa és el fitxer netlist fitxer.mnl 
generat amb el programa Orcad Capture. 

En aquest treball farem una breu introducció al disseny amb el programa Orcad 
Layout. Per a un aprofundiment més concret sobre l’utilització d’aquests programa s’ha 
d’anar al User’s Guide de l’Orcad Layout. 
 El programa Orcad Layout té un seguit d’ordres, disposat en dues fileres. Una 
primera fila del menú principal i una segona fila en forma de barra d’eines. La barra 
d’eines, que veiem tot seguit, ens facilitat el treball de disseny.  
 

 
 
El programa pot connectar els diferents components d’un circuit per capes o 

cares (“Layers”). El contingut de cada capa es divers, doncs hi ha capes de: traçat de 
pistes, de documentació, de forats, de dibuix de components etc., Les capes de les pistes 
del circuit elèctric poden ser 12 més positiu, més massa, més dalt (TOP) i sota 
(BOTTOM). Encara que els circuits més senzills són a una cara o dos (TOP o/i 
BOTTOM). 

El disseny del nostre circuit imprès comença carregant un fitxer de plantilla, 
fitxer.tch que ens subministra el programa Orcad Layout i que porta la informació per 
defecte del nombre de capes, dimensions estratègies de routing (espai entre pistes, 
diàmetre de les illes de coure etc.) a més de certs components fixes com a connectors i 
forats que hi ha al circuit imprès. El primer cop que entrem al programa, el fitxer de 
plantilla s’agafa dels que dona el programa, després emprarem fitxers modificats per 
nosaltres que s’adaptaran millor a les nostres necessitats. 
 
 
 
5. 1 Fitxer de treball de l’Orcad Layout 
 
 Per a crear el nostre fitxer de treball anomenat fitxer.max hem d’executar el 
programa d’Orcad Layout i entrar-li informació de les característiques físiques de la 
nostra placa (fitxer.tch o tpl) i informació de les connexions entre els components del 
circuit que ens porta el fitxer netlist (fitxer.mnl) obtingut de l’Orcad Capture que hem 
dibuixat amb, principalment, l’opció de polsades. 
Per a començar un disseny fem: 
 

New (la 1ª vegada) → Apareix Load Template (carregar per exemple default.tpl o el 
default.tch) 

→ Surt Load nettlist i s’ha de carregar el fitxer netlits fitxer.mnl 
 
 Per arribar a tenir el fitxer de treball, fitxer.max, el programa Orcad Layout 
necessita que quan fem el dibuix elèctric, amb l’Orcad Capture, posem el PCB Footprint 
de cada component ( tipus de component a l’Orcad Layout). Sinó hem fet això, 
l’haurem d’entrar en aquest moment, doncs el programa Orcad Layout ens el demanarà 
per mitjà de la pantalla següent. 
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Una manera de veure el PCB Footprint és entrant a l’icona Libraty Manager 
. Més endavant estudiarem aquest aspecte i d’altres que fan referència als 

components. Per mitjà d’Add podem afegir llibreries 
 
 

 
 
 

 Hi ha un seguit d’aclariments que hem de fer abans de començar. Primer que en 
preferència i si no diem el contrari, treballarem amb mils, mil·lèsimes de polsada, 
perquè és la unitat que fan servir el circuits integrats. 
 

1 mil = 1 polsada/1000 = 2,5 cm/1000 = 0,25 mm 
 

I segon que el fitxer de tecnologia carrega un seguits de paràmetres físics 
necessaris pel disseny i que tot seguit que podem veure i modificar a → System settings  
i que passem a definir 
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1. Visible grid. Assigna el grid (distància entre marques a la pantalla) de la 
pantalla de disseny sinó es vol veure el grid se’l fa igual a “0”. Un valor 
estàndar és de 200 mils. 

2. Detail grid. Assigna el grid (separació mínima) de dibuix per a línies i text i 
està basat en les coordenades X i Y. Pot ser tant baix com 1 mil. 

3. Routing grid. És el grid emprat per el routing. Mai pot ser més petit de 5 
mils. 

4. Placed grid. És el grid per al posicionat del components. Ha de ser multiple 
del routing grid 

5. Via grids. És el pas mínim amb que el  router pot posar vies. 
 
 
 
Per veure les mides d’un component fem tres passo 
 
 
 

1 Calibració: Anem a Options System Settings i activem els cm o mm 
2 Traçat de distància: Tool, Measuremen i unim els dos punts a mesurar 
3 Lectura: A Total, regla de sota de la pantalla, hi la distància buscada 

 
 
 

En principi el fitxer Template que nosaltres carreguem sempre és el fitxer 
DEFAULT.TCH que ens subministra el programa de Layout en el directori Data. 
Aquest fitxer porta informació en mils, mil·lèsimes de polsada, de circuits integrats amb 
encapsulats DIP, pad de 62 mils i forats de 38 mils (drills), grids per a routing  i per a 
vies de 25 mils, placement grids de 100 mils i espai de rutat de pistes de 12 mils. 

Altres fitxers de tecnologia que podem emprar es troben al directori Data són el 
1Bet_any.tch molt semblant al fitxer dafault.tch, el metric.tch basat en plaques amb 
mides en el sistema mètric. Els fitxers Jump*.tch recomanats per plaques a una cara. 

Un cop fet això ens a surten els components enllaçats per el punts de connexió 
(no són les pistes), ara hem de posar els límits de la placa (en cas de que el fitxer.tch no 
els porti) fent 
 

  → botó dret → New 
 
O amb les ordres de la primera filera del menú  
 

Tools → Obstacle → New 
 
Aquí fem un quadrat amb el ratolí. Aquests límits estan a la capa de global layer i són 
de color groc. 
 Tot seguit s’ha de posar cada component a dins de la placa, per fer-ho es poden 
posar de forma automàtica o manual.  
 Per a posar el components manualment primer l’hem de seleccionar i després 
fixa’l al circuit fent. Abans de fer rés hem d’activar el DRC amb l’icona . A més a on 
vulguem posar components s’ha de definir la finestra DRC anant a  
 

View → Zoom DRC route box. 



Orcad 
 

 

14

14

Podem seleccionar un component amb l’icona de Component Tool , al damunt 
de cada component i prement el botó dret i podem editar i fixar el component.. 
 Els components que hem carregat amb el netlist els anem posant a dins de la 
placa (l’obstacle definit al començar el disseny) fent: 
 

Portem el component a dins de l’obstacle  cliquem botó dret  Place 
 
 
A dins de Place posem la referència del dibuix Orca (Ref. Design) 
 

I per a fer-ho de forma semi-automàtica un cop som al damunt del component 
cliquem i anem a Place, tornarem a clicar, i seleccionem un component de forma 
automàtica 

Si cliquem el botó esquerra podem fixar o lock el component, la millor opció si 
no es la versió final és posar els components lock, perquè és més fàcil de modificar. 

Una altra forma de seleccionar un component (sempre que no estigui fixat) amb 
la primera fila del menú principal és 
 

Tools → Component →Select Tool 
 
 Per seleccionar un component fixat anem a 
 

Tools → Component → Select filtered (posem Ref. Des) 
 
 Si posem els components de forma automàtica s’ha de carregar el fitxer 
d’estratègia. Hi ha fitxers d’estratègia de Placement i fitxer d’estratègia de Routing. 
Tots tenen l’extensió .SF i els fitxers d’estratègia de Placement comencen per PL. Els 
més comuns són els STD.SF i PLSTD.SF. Fem  

 
Load PLSTD.SF 
 
Auto Place  Place Board 
 
Load STD:SF 
 
Auto Route Board 

 
 
 

SEMPRE QUE VULGUEM SORTIR D’UNA ORDRE, S’HA D’APRETAR EL 
BOTÓ DRET I VALIDEM: END COMMAND. 
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5. 2 Barra d’eines 
 
 La barra d’eines esta a la segona fila de la pantalla del menú principal. A la 
majoria d’ordres de la barra d’eines s’hi pot arribar amb la primera fila d’ordres del 
menú principal, però resulta més feixuc. Seguidament fem una descripció de les ordres 
que podem ordenar al programa de rutat agrupades en grups segons la informació que 
ens aporten.  
 
La barra d’eines porta informació de: 
 

1. Ús General de fitxers 
2. Spreadsheet o característiques ampliades 
3. Preparació del circuit abans de fer les pistes 
4. Edició i rutat de pistes 

 
 
 
 
5. 2. 1 Ús general de fitxers 
 
 A més de les feines generals de treball amb fitxers com són : obrir, guardar i 
buscar fitxers, hi ha una icona per a Library Manager  que ens permet visualitzar 
tots els elements de les llibreries de l’Orcad Layout. Amb aquesta opció podem 
visualitzar tots els paràmetres físics (pads, mides de l’encapsulat etc.) i en concret tot el 
que fa referència al PCB Footprint. 
 
 
 
 
5. 2. 2 Spreadsheet 
 
 La utilitat Spreadsheet és fa servir molt per a veure les propietats dels elements 
que intervenen en el disseny d’un circuit imprès. Aquest menú 
ens permet accedir a les següents opcions  
 

1. Strategy. Defineix l’estratègia de routing 
2. Layers. Edita les capes o cares d’un circuit imprès. 
3. Padstaks. Edita les propietats dels pad 

(dimensions i forma) 
4. Drill. Veiem els forats 
5. Packages. Ens diu les encapsulats dels components 

del nostre circuit. 
6. Nets. Visualitza les connexions (nets) 

 
 

Tot seguit fem una petita explicació d’algunes de les 
propietats més importants d’aquestes ordres. 

Quan comencem el diseny d’un circuit hem de definir el nombre de capes, fent 
el seguit d’accions  
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Layers → Selecció de la capa →Properties (botó dret), roting o unused routing 
 
 
 

 
 
 
 Cada capa té un nombre associat, que surt a la tercera fila del menú principal. 
Podem seleccionar cada una de les cares posant nombres naturals (0, 1, 2 ..). Per 
desactivar una capa s’ha de teclejar el signe -. 
 
 

 
 
 
Per activar/desactivar cap també podem anar a la icona de Color Settings o a 

options color i ens posem al damunt i escrivim amb el signe -. Algunes de les capes més 
emprades són la de les mides dels components AST (ASYTOP) color verds dels límits 
dels components i la SST (SSTOP) dels components  el Place Outline (Global Layer) 
per a dibuixos. 
 
 

Quan volem canviar els pads, primer seleccionem el component i anem a: 
 

View Spreadsheet  Padstack → Properties →Routing o unused routing 
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 Una aplicació molt interessant d’aquest últim apartat és quan volem que un 
connector només tingui pistes per la cara de sota (BOTTOM). Aquest cas se’ns presenta 
quan no podem soldar pistes de dalt del circuit amb els pins del connector. En aquest 
cas el primer que fem és seleccionar el component i després fem  
 

Spreadsheed → Padstack 
 
 Un cop fet això els diferents pins del connector estan seleccionat i nosaltres 
anirem passant per cada capa TOP 
 

TOP → Properties → Botó dret → Disable 
 
 Una altra propietat molt emprada és la que ens dóna la informació de les 
connexions del circuit, nets. 
 
 

 
 
 
 Uns valors estàndar per als nets són 25 mils i 75 mils per als padstack. 
 Aquesta pantalla ens permet, en d’altres coses, habilitar o no una pista de 
connexió alhora de dissenyar el circuit imprès. Aquesta utilitat ens permet rutar primer 
les pistes més llargues (Vcc i GND). Activant primer les pistes que interessant i 
desactivant les altre. I després es fa a l’inrevés  
 Perquè el programa Layout només dibuixi les pistes d’un component per una 
cara (connector, integrat etc.) se l’hi- ha de dir. Aquesta opció és molt interessant quan 
hi ha components què no es poden soldar per la cara Top. Primer seleccionem el 
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component i després anem a Padstack i a les capes què han estat seleccionades anem <a 
properties i lo diem no connect. 
 
 
 
 
5. 2. 3 Crear un component nou 
 
 Un cop a dins de l’opció de Library Manager podem crear components nous de 
l’Orcad Layout. Per a fer un component nou, podem dibuixa’l tot de nou o bé 
modificar-ne un que ja existeixi.  
 Per crear un component nou anem a  
 

Create New Footprint → Nom del component 
 
I després creem una llibreria (.llb) que tindrà el component nou amb  
 

Save as → Nom del component → Create New Library 
 
I un cop tenim creat el component podem dibuixar o esperar a crear i la llibreira.  
 Per afegir un component nou a la llibreria, un cop el tenim creat fem  
 

Save as a la llibreria que volem 
 

 Per fer pads nous anem al botó dret i activem New . Per a treure text, primer el 
seleccionem amb el T activat i després l’esborrem . Per a treure els dibuixos blancs del 
components anem a la capa SST (capa 11) i per a treure les lletres verdes anem a la capa 
AST (capa 9) . Per tornar a dibuixar anem a lla capa SST amb la pestanya d’obstacles 
activada. 
 
 
 
 
5. 3 Eines de preparació abans de fer les pistes 
 
 Amb les eines que hi ha la part del mig de la segona barra de la pantalla podem 
donar algunes ordres que ens poden ser de molta utilitat abans de fer el rutat de les 
pistes. 
 
 
 

 

Component Tool. Amb ell activat seleccionem un component  
Pin Tool. Ens permet afegir un pin a un component 
Obstacle Tool. Permet crear límits en un circuit imprès 
Text Tool. Afegeix text 
Connection Tool. Fa nets que s’hagin oblidats en el capture 
ErrorTool. Activa els controls d’errors 
Colors settings. Permet canviar els colors de les capes 
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5. 4 Rutat i edició de pistes 
 
 Un cop tenim configurada  la plantilla de la placa, fets els seus límits i amb els 
components posats a dins seu (vegeu l’apartat 3.1), anem a fer el rutat automàtic dels 
nets permesos fent: 
 

Options  Auto Route (Board, DRC/route box) 
 
 El programa Orcad Layout ens farà les pistes permeses i després podem fer 
servir quatre opcions per a perfeccionar el routing automàtic. En general fer un rutatat 
s’ha de tenir activat el DRC (ON). 
 

 
 
 A totes les opcions de perfeccionament de rutat s’hi pot arribar per les icones de 
la segona fila o per l’ordre de la primera fila  
 

Options  Route Settings (opció OR) 
 
Seguidament fem una explicació de cada una d’aquestes opcions, juntament amb 

la seva icona corresponent. 

 Auto path route. Edita nets. Al seleccionar un net suggereix possibles 
trajectòries de pistes (al clicar) i edita pistes. Posa i treu de forma automàtica vies. Si 
entrem amb l’opció OR podem definir: 
 Allow grid routing. Permet rutar sense tenir en compte el grid 
 Shove components. Permet moure components que no siguin locked 

Shove track mode. Edita nets. Canvia pistes automàticament al voltant de la que 
rutem, no posa vies de forma automàtica (se l’hi ha de dir amb el botó dret → Add via) i 
edita pistes. També pot moure vies. Si entrem amb l’opció OR podem moure les pistes 
poc, lleugerament i molt (low power, medium power i high power). 
 

 Edit segment. Mou pistes i vies. 
 

 Add/edit. Edita pistes. Pot crear pistes si li entrem un net. Permet editar pistes 
sense des-rutar-les (clicam el botó esquerra. Quan fa pistes, emprant l’opció OR, pot 
posar vies (Use all vias) o no mirar de forma automàtica la relació pista/routing grid. 
Quan rutem hi s’ha de posar una via la pista canvia de color i li hem de posar la cara a 
on hi ha la pista (generalment 1 o 2).Seleccionem la pista amb add/edit seleccionat 
→botó dret → unroute 
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  Reconnect mode. Edita pistes. Permet veure els nets o no 
 

Refresh all. Actualitza la pantalla. 
 
 
 
 

6 Altres opcions interessants 
 
 Hi ha un seguit de temes que ens permeten acabar de completar els circuits 
impresos i que no estan encabits en els apartats estudiats abans, i que passarem a 
explicar de forma ràpida. Entre aquests temes aplicacions a circuits SMD, creació de 
zones de coure i pad especials per a soldar amb màquines de soldadura. 
 
 
6. 1 Fan out 
 
 És una opció que es fa servir per a rutar dispositius de muntatge superficial, 
SMD ( surface mount device). Els dispositius SMD només tenen pads en una cara del 
circuit imprès, la (BOTTOM). Amb aquesta opció activada l’Orcad Layout posa de 
forma automàtica vies per a cada pad que no esta connectat. 
 

Options →Fanout Settings (prepara les opcions del fanout) 
Seleccionem component amb l’icona premuda → shift + icona 

Auto → Fanout Board, DRC o Component 
 
 L’aspecte del net d’un component SMD després d’aplicar-li un Auto Fanout 
Component és 
 

 
 

 
Per a fer el rutat automàtic fem  Autorute → Board, DRC o component i finalment les 
pistes tenen l’aspecte següent 
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 De totes maneres aquesta opció no és gaire emprada, doncs per a dispositius 
SMD s’acostuma a posar les vies de forma manual (escollint el net i apretant el botó i 
fent Add via). 
 
 
 
 
6. 2 Creació de zones de coure 
 
 Al fer un circuit imprès, en alguns casos necessitem crear zones de coure o 
copper-pour zones. Uns exemples d’això són plans de massa i pads en  termals reliefs. 
Perquè aquesta opció es pugui fer servir hem de tenir activada l’opció Options Enable 
copper pour a User preferences. 

Per a fer una zona de coure, abans, s’ha de crear un obstacle, Hi ha tres tipus de 
zones de coure. 

 
1. Anti-copper. Crear una zona de no coure a dins d’una zona de coure 
2. Copper area. Són zones de coure a on no es poden rutar pistes (plans de 

massa) 
3. Copper-pour. Zones de coure que permeten rutar pistes de coure aïllades. 

 
 
 
 
6. 2. 1 Zones de copper-area 
 
 Si volem fer una zona de coure connectada a un pad hem de crear abans un 
“Seed” (llavor) assignat al pad. Per a aconseguir-ho seleccionem el pin a on volem 
connectar la copper-pour amb el botó dret validen Togle Copper Pour Seed 
 Un cop fet això, sortirà una X sobre el pin de la pantalla, això ens serveix per a 
identificar el pin com a un punt Seed. 

Ara ja podem passar a fer la zona copper-pour, abans hem de fer un obstacle de 
la mateixa forma que el copper-pour que volem. 
 

 → bot dret →New i dibuixa l’obstacle 
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L’altre manera és 
 

Obstacle, New → cliquem botó dret i fem l’àrea → Properties (selecció de capa) 
 
Un cop fet això ens surt la pantalla següent. 
 
 

 
 
 
 
I tretze tipus d’obstacles 
 
Anti-copper. És una zona de no coure a dins d’una copper-pour 
Board outline. Línia que defineix la placa 
Comp keepin i keepout en diferents versions. Característiques de components 
Cooper area. Zona de coure a on no es poden rutar nets 
Copper-pour. Per fer coexistir el coure i els nets 
Datail. No emprada per a placing o routing, porta informació dels forats i components. 
Free track. Línia o pista assignada aun pin o a un net.. 
Insertion outline. Defineix mida i forma dels components. 
Place outline. Informació dels components 
Route keepout Àrea que exclou pistes rutades 
Route via keepout. El mateix però amb vies 
Via keepout. Semblant als altres. 
 
 
A dins de l’opció copper-pour especifiquem : 
 
 Clearence (distància). Distància de les pistes a la zona copper-pour. Si és zero 
el programa agafa la distància per defecte. 
 Isolated all tracks. Permet el rutat de totes les pistes i vies. El resultat és un 
circuit amb totes les pistes envoltades per zones de coure. 
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 Seed. Només els pads marcats amb X són pads Seed. A un punt Seed se l’hi pot 
assignar un thermal relief. 
 

 
 
 Net attachment. És el nom del net a on va el pad al que volem fer un thermal 
relief o un seed 
 Hatch pattern. Serveix per a distinguir tipus de zones de coure (amb dibuix 
com la figura d’abans o sense dibuix). 

Una manera molt útil de seleccionar una copper-pour o qualsevol obstacle és 
posant-nos en una cantonada de l’obstacle i fe CTRL + clicant el botó dret. Per sortir de 
l’edició de l’obstacle a l’acabar, encara que les línies es moguin, apretem el botó dret i 
fem End command. 

Per a esborrar un obstacle, primer es selecciona l’obstacle i després anem 
esborrant un costat darrera l’altre amb la tecla Suprimir. 

De tant en tant s’ha de donar l’ordre de Refresh all  per a refer la informació 
de la pantalla, 
 
 
 
 
6. 2. 2 Thermal relief 
 
 Aquesta opció és emprada per a fer plans de massa o per a fer zones copper-pour 
en les connexions de les masses. 
 La connexió d’un pad a una massa es divideix en quatre trossos a fi i efecte de 
fer la superfície de connexió més petita. Així quan soldem els components per 
soldadura per bany d’estany la massa, al tenir molta superfície, s’escalfa molt i pot fer 
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malbé, si la placa el porta, un circuit integrat. En canvi si disminuïm la superfície de 
contacte (quatre punts) el calor no circularà tant bé cap el circuit integrat, disminuint el 
perill de cremar-lo 
Per a veure la configuració dels relleus tèrmics anem a: 
 

Options  Thermal Relief Settings 
 
Normalment el programa carrega defecte una configuració per defecte de Small 

Thermal Relief (spoke<100, isolation<50 i drill<50) , si volem canviar el Thermal 
Relief d’un pad concret, hem de  

 
seleccionar el pin → spreadsheet → padstack → properties→ Large Thermal 

Relief settings 
 

Els paràmetres a tenir en compte són el diàmetre del pad, clearence (distància 
del coure al pad i pistes) i spoke width (amplada de cada una de les quatre connexions 
pad/coure) 

Per a que un pad sigui thermal relief hem de posar el nom del net al menú d’Edit 
Obstacle, dins d l’opció Net attachment. Un pad amb thermal relief té un aspecte com el 
de la figura. 
 

 
 
 
 
 
6. 2. 3 Dimensions de la placa 
 
 Per a poder saber les mides d’una placa i posar-les al dibuix, posen les 
dimensions de mesura en centímetres, anant a Optins → Settings, i després mesurem, 
fent: 
 

Options  System Settings 
 

Tool  Dimension  New 
 
Si només volem saber la mesura de forma ràpida, anem a: 
 

Tool → Measurement → Select Tool → Seleccionem i cliquem 
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6. 2. 4 Importació d’un dibuix emprant DXF 
 
 Serveix per a importar dibuixos en format DXF, fitxers d’Autocad i anagrames 
d’empreses. 

1. Hem de tenir un fitxer. DXF, creat amb Autocad o visual CADD o qualsevol 
altre aplicació mecànica. 

2. Des del programa Layout fem: File → Import → DXFto layout 
3. Contestar a les preguntes: Input → fitxer.DXF (browse); Output layout File → 

fitxer.MAX; DXF.INI → MAXDXF,INI. 
4. Des del programa Layout seleccionem el fitxer.MAX del pas 3. File → Open 

→seleccionem la capa a on és el dibuix DXF. 
5. Per a poder tractar el dibuix l’hem de seleccionar i per a seleccionar el dibuix 

anem a. La icona de Component Tool cliquem dues vegades i mirem la 
referència que per el fitxer polyline.DXF és U1.  

6. Un cop seleccionat el tractem com a un obstacleper per fer que sigui un límit del 
circuit imprès, per a exemple, fent: View Spreadsheet → els dibuixos en forma 
d’obstacles queden seleccionats → sense sortir, premem el cursor al damunt del 
fons negre i → cliquem el botó dret del ratolí → properties 

7. Posem: Obstacle layer → global layer (ni top ni bottom) i Obstacle type → root 
keep out o board outline (contorn). 

 
 
 
 
6. 2. 5 Opcions amb lletres 
 
I i O  augmentar i disminuir 
C     → centrar dibuix (Capture) 
Drc normalment ha d’estar a OFF 
Statistics → per veure la densitat de les pistes rutades 
Auto → clean up design valida i torna a dibuixar. 
 
 
 
 

7. Post processing settings 
 
Aquesta opció ens permet imprimir les capes del dibuix que vulguem i els fitxers 

de taladres i de dibuix dels components del circuit etc. S’hi entra amb 
 

Options  Post Processing Settings 
 

Window  Tile (layers i capa seleccionada)  Preview 
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Queda com a la figura 
 
 

 
 
 
I per imprimir la capa 
 

File  Print/Plot 
 
 Perquè no ens surti la Drill Chart (forats), s’ha d’imprimir des de Post 
Processing Settings o no seleccionar la capa DRLWG. 
Un cop s’ha acabat fem 
 

Window → Reser All 
 

Una altra utilitat l’ordre de Post Processing Settings és que ens permet veure les capes i 
la informació del que hi ha a cada capa. 
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Per imprimir els pads d’un circuit imprès i que quedin amb forat al fotolit i així 
fer més fàcils els taladres seleccionem la capa del circuit imprès que volem dibuixar 
anant a: 
 

Post Processing  Preview  Activant Design Component Tool DRC (on) 
 
Tot seguit anem a  

 
File → Print/Plot 

 
Amb les opcions 
 

• Keep drill holes open 
• Force black &white 
• Center page (no) 
• Mirror (només per a la cara top 

 
Per generar el fitxer dels forats thruhole.tap, necessari per a algunes màquines que 

fan forats. Hem d’activar la cara top, bottom, drill i drldwg, això ho fem anant a  
 

Speadsheet → layer 
 
 Tot seguit executem Run posprocessing, anem a properties i activem extender 
gerber amb totes les opcions activades. 
 
 
 
 

8 Regles pràctiques de disseny 
 
 Tot seguit exposarem algunes regles bàsiques per dissenyar circuits impresos 
que ens serviran per col·locar millor els components a fi i efecte de construir un circuit 
imprès real.  
 Començarem per dues regles, la primera és posar els components electrònics a la 
cara de sobre (Top) i la segona és que les pistes de connexió es fan tant curtes com es 
pugui. 
 Atès que els elements actius, principalment transistors bipolars i MOS, fan una 
conversió de potència continua a potència alterna, combinem de corrent continu (c. c.) 
amb potència de corrent altern (c.a.). A la propera figura podeu veure, de forma 
simplificada, com es combinen c. c. i c. a. en un circuit amplificador. Aquest circuit pot 
representar amb precisió la sortida d’un circuit integrat d’àudio o digital. 
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 En aquest cas suposem que el senyal és de radiofreqüència, com podem deduir 
per la presència d’un circuit sintonitzat LC en el col·lector. El xoc de radiofreqüència 
(XFR) es posa perquè la radiofreqüència no influeixi sobre la font d’alimentació de c. 
c.. És a dir que pel senyal de radiofreqüència podem suposar la impedància de la font de 
c. c. és zero. El corrent de la font de c. c. només serveix per polaritzar el transistor però 
no va al circuit sintonitzat, i el senyal de radiofreqüència només passa pel circuit 
sintonitzat. 
 Si la impedància de la font de c. c. a la radiofreqüència no és zero, es posa un 
condensador CP en paral·lel amb la font de la font de c. c.. Que la resistència no sigui 
zero a la pràctica pot passar perquè les pistes de connexió siguin massa llargues. 
 

 
 
 Aquest condensador CP s’escull de manera que ofereixi baixa reactància a la 
freqüència de treball. Per aquesta raó el senyal de radiofreqüència passa per CP i no per 
la font de c. c.. Com a regla de disseny, la reactància del condensador CP ha de ser més 
petita que una dècima part de la impedància a desviar (font). 
 Aquest mateix esquema de posar un condensador en paral·lel amb la font de c. c. 
serveix per eliminar sorolls que venen de la font d’alimentació i que poden influir en el 
funcionament de l’amplificador. Per aquesta raó, en tots els circuits integrats s’acostuma 
a posar un condensador CP a positiu per eliminar sorolls que puguin vindre de la font 
d’alimentació. 
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 Quan dos circuits electrònics pròxims es puguin influir direm que estan acoblats. 
Aquest acoblament es pot establir perquè les parts metàl·liques dels circuits formen una 
petita capacitat, per la que es pot transferir energia per mitjà del camp elèctric. Això 
passa quan treballem a freqüències de VHF i UHF. 
 Una altra forma d’establir acoblament es per mitjà del camp magnètic generat 
per una inductància o pistes del circuit imprès que es poden acoblar amb un segon 
circuit magnètic. Això també passa quan treballem a freqüències de VHF i UHF. 
 
 En molts casos aquests acoblaments no són desitjats, i s’ha de procurar que no es 
generin.  
 L’acoblament per capacitat es pot tractar fàcilment tancant un dels circuits o tots 
dos en compartiments metàl·lics anomenats blindatges, que es connecten a terra. El 
camp elèctric generat pels components no travessa el blindatge. 
 L’acoblament magnètic es redueix apantallant o aïllant cada component que 
generi camp magnètic (inductàncies i transformadors) per separat. Les pantalles 
utilitzades per tractar l’acoblament per capacitat són bastant ineficaces com a blindatges 
magnètics. 
 
 
 
 

9 CIRCUITS IMPRESOS A FREQÜÈNCIES ALTES (RF) 
 

 
 

 
 En el disseny de circuits a freqüències elevades cal tenir en compte aspectes físics dimensionals 
més enllà dels purament topològics o esquemàtics. Els programes convencionals de disseny de circuits 
(eg. Orcad) normalment sols consideren aquests últims, lo qual es vàlid sols per baixa freqüència. En 
aquest document s'indiquen les principals consideracions que cal tenir en compte en el disseny a alta 
freqüència.  
 
 Cal primer recordar quina es la frontera entre baixa i alta freqüència, des de aquest punt de vista. 
L'exemple mes clar està en una línia de transmissió d'un quart de longitud d'ona de treball. La seva 
impedància d'entrada es invers a la impedància de càrrega! (si acaba en circuit obert, a l'entrada veiem un 
curt-circuit). Mai per tant hem d'arribar a una situació com aquesta.  
 
 La frontera entre la baixa i l'alta freqüència s'acostuma a establir en 1/4 d'aquesta situació. Així 
dons, les dimensions físiques de les pistes del nostre circuit hauran de tenir una llargada inferior a λ/16. Si 
treballem amb el substrat comú de fibra de vidre, i per exemple tenim pistes de 10 cm, la freqüència mes 
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elevada que podrem treballar seria de 100 MHz. O viceversa, reduir les dimensions de les pistes i 
components.    
 
 Si hem de treballar a freqüències per sobre d'aquesta frontera (es lo habitual en sistemes de radio, 
de fibra òptica i també, ja avui dia, de disseny digital), haurem de guiar el disseny per incloure 
consideracions en aquest sentit: 
 
 
 
 
9. 1. Utilització de components de muntatge superficial (SMD). 
 
 Aquests components son de dimensions força reduïdes i tenen menys elements paràsits que els 
components convencionals. Es solden per la mateixa cara a on hi ha el component (no te "potes").  
 
 
 
 
9. 2. Consideració dels efectes paràsits dels components.  
 
 Aquests efectes es poden modelar amb un model circuital que s'adapti al comportament del 
component en alta freqüència. Els principals a RF son: 
 
- Resistència: es modela amb una inductància en sèrie, que es l'efecte dels electrodes principalment, i una 
capacitat en paral·lel, que afecta quan el valor de la resistència es elevat. 
 
- Condensador: el model equivalent inclou una resistència de fugues, en paral·lel amb la capacitat, i una 
resistència i inductància en sèrie. Cal veure a les especificacions que el valor d'aquests elements, 
quantificats sovint a través del factor de qualitat i de la freqüència de ressonància sèrie siguin prou elevats 
per la freqüència de treball.  
 
- Inductància. Poden ser de nucli de ferrita, nucli d'aire, impreses o de sintonia de RF.  
La inductància d'una bobina al aire es pot dissenyar fàcilment amb la següent formula empírica 
aproximada: L= 0,0395 a2N2/l microHenrys, a on a= radi de les espires, N el número d'espires, i l la 
longitud de la bobina (es suposen espires juntes). Les  inductàncies son uns elements amb molt efecte 
paràsit: resistència sèrie de pèrdues del conductor i una capacitat en paral·lel, corresponent a la capacitat 
distribuïda entre espires. I per evitar interferències electromagnètiques convé apantallarles o blidarles. La 
capacitat paràsita es pot utilitzar beneficiosament per formar un circuit ressonant, que s'ajusta separant o 
apropant les espires.  
 
 Tots aquests elements paràsits es redueixen usant components SMD, i quan es possible, 
components impresos.  
 
 
 
 
9. 3. Disseny amb components impresos. 
 
 La mateixa forma que li donem al coure de la placa de circuit imprès pot actuar com alguns 
dispositius passius. Això té l'avantatge que es pot implementar fàcilment amb gran precisió (sols 
controlant les dimensions de les pistes) i que els programes de simulació de circuits de microones 
modelen molt be el comportament dels elements impresos.  
 
- elements concentrats (l<<λ): per exemple, una bobina es pot implementar amb una pista en espiral 
(element SPIND d'algun software comercial): o un condensador en sèrie es pot fer amb dues pistes molt 
properes amb ranures intedigitals.   
 
- elements semi-concentrats (l<<λ): com sabem, una línia de transmissió (pista) curta te un circuit 
equivalent composat per una inductància sèrie i una capacitat paral·lel, directament relacionades amb la 
impedància característica i l'índex de refracció efectiu del medi. Segons això, una pista ampla s'aproxima 
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a un condensador (podem calcular la seva capacitat com la de un condensador ideal de plaques paral·leles, 
en primera instància), mentre que una pista estreta s'aproxima a una inductància. 
 
- línies de transmissió (stubs): aquí ja no cal fer cap aproximació sinó que es treballa amb la teoria exacte 
de microones. Es podem implementar així a alta freqüència i de forma molt precisa: filtres, acopladors, 
ressonadors, etc. 
 
 Aquest tipus d'elements es fan amb configuració Microstrip, que consisteix en fer pistes i 
components en la cara superior (TOP) mentre que l'inferior (BOTTOM) es tota pla de massa. D'aquesta 
manera els camps electromagnètics queden guiats de forma ben confinada, i la fabricació del circuit es 
senzilla.    
 
 
 
 
9.4. Línies Microstrip i substrat.  
 
Els paràmetres eléctrics de les línies de transmissió son:  

• Impedància Característica  
• Desfasament o retard.  

 
depenen respectivament dels paràmetres físics:  

• Amplada de la línia 
• Llargada de la línia 
• Constants del substrat, bàsicament: 

 gruix (eg. 1,5 mm típic en fibra de vidre) 
 constant dieléctrica (eg. 4,5 típic en fibra de vidre) 

 
 Per trobar la relació entre els paràmetres físics i els elèctrics cal recorre a formules empíriques o 
millor al simulador (Vipec, ADS, Touchstone, Puf, ...).  
 
 En concret, per exemple, trobem que el gruix de una línia de la impedancia nominal de 50 Ohms 
en la fibra de vidre especificada ha de ser de 2,8 mm, i que la longitud d'ona (desfasament de 360º) es de 
163 mm (a 1GHz). Aixó correspon a un índex de refracció efectiu de 1,84 i a una constant dieléctrica 
efectiva de 3,4, que veiem que es inferior a la del substrat (degut a que part del camp viatja per fora). 
 
 Per 100 Ohms la línia es més estreta evidentment, de 0.64 mm, i la longitud d'ona de 171 mm.  
 
 
9. 5. Línies curtes.  
 
 Evidentment, per tal d'evitar la problemàtica de l'alta freqüència, es convenient fer les pistes 
normals (la seva funció es simplement unir 2 punts ) tant curtes com puguem (<λ/16). L'opció més 
avantatjosa en aquest sentit son evidentment els MMICs. 
 
 
 
 
9. 6. Adaptació d'impedàncies.  
 
 Quan tenim una pista que per un motiu es llarga (>λ/16), per exemple l'entrada o sortida del 
circuit, cal que tingui adaptació d'impedàncies, o sigui que tant la del generador d'entrada, com la càrrega 
de sortida, com la impedància nominal de la línia siguin iguals. En cas contrari es produeixen distorsions 
en freqüència, i pèrdues de potencia.  
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9.7. Retard. 
 
 Sobretot en circuits digitals d'alta velocitat, els retards entre els senyals dels diferents elements es 
crític, ja que operen actualment a freqüències de rellotge superiors al Giga-Hertz. El retard de propagació 
en la placa de circuit imprès de fibra es de 61 ps/cm, lo qual no es despreciable (cal contar la llargada en 
mil·límetres de les pistes).  
 
 
 
 
9. 8. Acoblament entre pistes.  
 
 Quan la distancia entre dues pistes es inferior o comparable a la distancia a massa, i estem en la 
condició d'alta freqüència, es pot produir un fort acoblament entre pistes, que provoca interferències i 
pèrdues de senyal (sols son desitjades si volem dissenyar un acoblador). Per tal de minimitzar aquest 
efecte cal separar les pistes aproximadament en una distancia superior al gruix de la placa microstrip. 
També es pot incloure un apantallament (per exemple un "Obstacle" del Orcad, a massa), o altres 
consideracions de EMC.  
 
 Per concretar aquests conceptes es proposa la Pràctica 2: Circuit Amplificador i Filtre de RF 
(aplicació per TV).  
 
 Cal esmentar que aquestes tècniques no son suficients per dissenyar circuits a freqüències molt 
elevades (microones, milimètriques, ..) i que cal comptar amb un bon simulador per precisar i ajustar els 
dissenys finals.  
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